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Budget Structure and Narrative Templates 
These instructions are intended to provide information for preparing 2022-23 biennial budget narrative 
submissions by providing guidance on how to present your budget based on your agency’s budget 
structure.  

How is budget structure used? 
Agency budget books, narratives and fiscal reports are organized around an agency’s budget structure as 
established in the accounting system, SWIFT. Each agency has a budget structure to define how it plans 
and manages its work, allocates resources, and achieves and reports on results. It serves as an important 
tool, used by the governor and legislature in making decisions about allocating resources and in 
measuring agency success in achieving its goals.  

Changes to your agency budget structure need to be reviewed and approved by your executive budget 
officer (EBO) prior to entry into the accounting system - SWIFT or the Budget Planning and Analysis 
System (BPAS). If a new budget program or activity is being added or a program or activity name change 
is being requested, the agency must submit the Budget Structure Change Form (http://mn.gov/mmb-
stat/documents/swift/forms/budget-structure-changes.xlsx) to their executive budget officer (EBO). 
These changes must be submitted to your EBO prior to August 14. 

Agency Profile Change 
The “Purpose” section of the agency profile will no longer reference the eight statewide outcomes that 
were developed in 2012. References to the statewide outcomes were removed from the 2020-21 
agency profiles that are uploaded to the MMB Budget Division Document Management SharePoint Site 
as a starting point for agencies in developing their profiles for the 2022-23 biennial budget. 

Narratives Uploaded to SharePoint Site 
Agencies not making changes to their budget structure or presentation should start with the budget 
narratives published with the 2020-21 budget document. The 2020-21 narratives are updated for 
template changes and 2019 data in the profile pie and bar charts. These updated narratives are 
uploaded to the MMB Budget Division Document Management SharePoint Site 
(https://mn365.sharepoint.com/sites/MMB-Budget/SitePages/Home.aspx) under your agency’s folder: 
Biennial Budget/2022-23 Biennial Budget/Background Narratives/2020-21 Narratives. If your agency did 
not use data from the Budget Planning and Analysis System (BPAS) or the consolidated fund statement 
to populate the pie or bar charts, your agency will need to update its own charts. 

How do I choose a presentation structure? 
You must determine how your agency’s budget should be presented. Each agency is required to 
complete an Agency Profile or Small Agency Profile. The Small Agency Profile is for “small” agencies that 
perhaps only have one program and budget activity or do not use the SWIFT accounting system. Small 
agencies do not need to complete a Program or Budget Activity Narrative. 

The larger agencies must complete the Agency Profile, and Program or Budget Activity Narrative 
templates. In order to reduce duplication, agencies may choose to report information at the program 

http://mn.gov/mmb-stat/documents/swift/forms/budget-structure-changes.xlsx
https://mn365.sharepoint.com/sites/MMB-Budget/SitePages/Home.aspx
https://mn365.sharepoint.com/sites/MMB-Budget/SitePages/Home.aspx
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level or the budget activity level. You should make this decision based on your agency’s program and 
budget activity structure, how results are measured, and how resources are allocated. Please consult 
with your EBO to decide which level is the most informative for your agency. Once the decision has been 
made, agencies will need to complete one template for each program or budget activity. 

Presentation options include: 
• Small Agency Profile only 
• Agency Profile + Budget Program Narratives 
• Agency Profile + Budget Activity Narratives 
• Agency Profile + combination of Budget Program and Budget Activity Narratives 

MMB has developed several templates to allow flexibility in agency’s budget presentations. There are 
two different templates available for both the Agency Profile and the Small Agency Profile. The only 
difference between the two templates is the pie chart, one displays Spending by Program, and the other 
displays Spending by Category. Choose the one that best presents your agency’s budget information. For 
example, if your agency only has one budget program, the Spending by Program would not be an 
informative graph. In this case, the Spending by Category would be a better choice. 

Resources 
• The 2020-21 published budget narratives with updated Microsoft Word templates and the 

profile pie chart and bar charts updated with FY 2019 data are uploaded to your agency’s folder 
on the Budget Division Document Management SharePoint Site 
(https://mn365.sharepoint.com/sites/MMB-Budget/SitePages/Home.aspx) under the agency’s 
folder: Biennial Budget/2022-23 Biennial Budget/Background Narratives/2020-21 Narratives). 

• Budget structure reports for BPAS are located in each agency’s folder on the Budget Division 
Document Management SharePoint Site under the agency’s folder: Biennial Budget/2022-23 
Biennial Budget/Background Narratives/Reference Materials. 

o Agency Budget Structure are the programs and activities for the agency with each 
appropriation, fund and type as it is currently assigned in the Budget Planning and 
Analysis System (BPAS). 

• All budget narrative instructions and templates can be found on the MMB Biennial Budget 
Instructions website (http://mn.gov/mmb/budget/budget-instructions/bibudprep/). 

• Contact your agency’s assigned EBO with questions or email budget.finance.mmb@state.mn.us.  

https://mn365.sharepoint.com/sites/MMB-Budget/SitePages/Home.aspx
https://mn365.sharepoint.com/sites/MMB-Budget/SitePages/Home.aspx
https://mn365.sharepoint.com/sites/MMB-Budget/SitePages/Home.aspx
https://mn365.sharepoint.com/sites/MMB-Budget/SitePages/Home.aspx
https://mn.gov/mmb/budget/budget-instructions/bibudprep/
https://mn.gov/mmb/budget/budget-instructions/bibudprep/
mailto:budget.finance.mmb@state.mn.us
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Completing the Budget Charts in the Agency 
Profile 

Overview of Templates 
For both the Agency Profile and Small Agency Profile, there are two templates available. The only 
difference between the two templates is the pie chart, one displays Spending by Program, and the other 
displays Spending by Category. Choose the one that best presents your agency’s budget information. For 
example, if your agency only has one budget program, the Spending by Program would not be an 
informative graph; therefore, the Spending by Category would be a better choice.  

Data for the Pie Charts 
For agencies who used BPAS data to complete the pie chart for the 2020-21 agency profile the pie 
chart is updated with FY 2019 data. If you would like to review the data used to complete the charts, 
the spending by category and spending by program data for each agency is uploaded to your agency’s 
folder on the Budget Division Document Management SharePoint Site 
(https://mn365.sharepoint.com/sites/MMB-Budget/SitePages/Home.aspx) in the Biennial Budget/2022-
23 Biennial Budget/Background Narratives/Reference Materials. The Excel spreadsheet is labeled 
“Narrative Pie Chart Spending by Category and Program”.  Use this report to review or complete your 
pie chart data based on either category or program within your narrative. The data for the pie chart is 
entered directly into the chart embedded in the budget narrative Word document template. 

The source of the data for the pie charts is BPAS. The data was loaded with FY 2019 close data in August 
2019 and includes any reconciliation the agency completed after load. The purpose of the charts in the 
narratives is to provide readers with a high level overview of your agency’s budget, displaying percent 
spending by category or program. The intent is for the data to present an accurate summary level 
display of your agency’s FY 2019 spending. 

Data for the Historical Spending Bar Chart 
For agencies who used consolidated fund statement data to complete the bar chart for the 2020-21 
agency profile, the bar chart is updated with FY 2018-19 data. If you would like to review the data used 
to complete to complete the historical spending bar chart, the Excel spreadsheet labeled “Narrative Bar 
Chart Spending by Fund.xlsx” is uploaded to each agency’s folder on the Budget Division Document 
Management SharePoint Site (https://mn365.sharepoint.com/sites/MMB-
Budget/SitePages/Home.aspx) in the Biennial Budget/2022-23 Biennial Budget/Background 
Narratives/Reference Materials. The Narrative Bar Chart Spending by Fund report contains general fund, 
federal fund and other funds spending by fiscal year for 2008-2019. The source of the data is historical 
consolidated fund statements for FY 2008 through FY 2011, and then BPAS for FY 2012-19. “Other 
Funds” does not include data for funds not included in the consolidated fund statement. The data for 
your agency may be entered directly into the chart embedded in the budget narrative Word document 
template. Instructions are on the first tab of the Excel workbook. 

https://mn365.sharepoint.com/sites/MMB-Budget/SitePages/Home.aspx
https://mn365.sharepoint.com/sites/MMB-Budget/SitePages/Home.aspx
https://mn365.sharepoint.com/sites/MMB-Budget/SitePages/Home.aspx
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Non-SWIFT Data 
Agencies that do not use the state accounting system (SWIFT) may use data from their accounting 
system to populate the budget charts on the narratives. The source of the data must be noted in the 
footnotes section under the budget charts. Please also provide your EBO with a copy of the source data 
reports.  
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Program Performance 
As statutorily required, the biennial budget narrative documents will continue to provide information on 
program performance. The program/budget activity narrative and the small agency profile ask you to 
describe the key data elements you use to measure successful outcomes or determine progress. 

The “Purpose” section of your profile will no longer reference the eight statewide outcomes that were 
developed in 2012. 

You have two options to display performance measure data: 

Option 1: The templates include a performance measure table to identify the measure, the most recent 
previous data point and the current data point, and the five- year trend (is it stable, improving, or 
worsening)? 

Option 2: If your agency has produced its own charts and graphs that demonstrate trends, you may 
include them in the document in place of the performance measures table.  

Choosing Performance Measures For each program or budget activity, agencies should list three to five 
performance measures.  

• Performance measures should be directly related to the program and/or activity goals and 
strategies with an emphasis on serving the program/activity’s customers. 

• Performance measures should incorporate significant aspects of program/activity operations. 

You are encouraged to include at least one of each of the following types of measures. 

Quantity: How much did we 
do? 

Quality: How well did we do it? Result: Is anyone better off? 

Counts customers served and 
activities performed, and are 
generally associated with 
agency workload or effort. 

Demonstrates how well the 
activities were performed, and 
usually measures efficiency, 
timeliness, accuracy, workload 
ratios, unit cost, staff turnover, 
etc. 

Shows the extent to which your 
customers are better off. This 
usually has to do with improved 
skills, knowledge, attitude, 
behavior, customer satisfaction, 
or life situation. 

Example: Number of children 
served. 

Example: Proportion of children 
served within 48 hours of 
application. 

Example: Proportion of children 
reporting improved health. 

Example: Number of clients 
provided job training. 

Example: Percentage of clients 
with child care and 
transportation needs met. 

Example: Percentage of clients 
employed 6 months after 
completion. 

Example: Number of job 
applicants processed. 

Example: Average recruitment 
period. 

Example: Non-promotion 
workforce turnover rate. 
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Plain Language and Style 
Agencies must use plain language when writing their budget narratives to help Minnesotans understand 
your agency’s mission, purpose and activities. Below are some tips on how use plain language 
specifically for the budget narratives. 

Plain Language 
What is Plain Language? 

A document is in plain language when the reader can find what they need, understand what they find, 
and use what they find to meet their needs on the first try. 

How do I write in Plain Language? 

Plan 

• Explain your purpose 
• Know you reader. Your readers are legislators, legislative staff, executive branch staff, and 

Minnesotans.  Your document should provide an objective, factual description of your agency’s 
mission, goals, activities, and results to these audiences. 

Organize 

• Determine your key message 
• Only include essential information, facts, data and details 
• Answer your readers anticipated questions 
• Determine a logical sequence of information 

Write 

• Use short sentences. If your reader has to read the sentence more than once to understand it, 
rewrite it! 

• Use active descriptive words 
• Use active voice 
• Use your readers words 
• Avoid jargon and legalese 

Edit 

• Use lists and tables 
• Use acronyms sparingly. If you must use them, spell them out the first time they are used in 

each document. 
• Remove unnecessary words 
• Watch for white space 

Review 

• Have someone unfamiliar with the document review it for understanding. 
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Style and Formatting Requirements 
Narrative Style  

• Use concise descriptions 

Audience  

The budget narrative documents are intended to provide an objective, factual presentation of your 
agency’s mission, goals, activities and results. They are not intended to justify budget requests or 
decisions, or discuss results of budget cuts. The audience includes legislators, legislative staff, executive 
branch staff and the public at large.  

Acronyms  

If you must use acronyms, spell them out the first time they are used in each document. 

Bullets and Numbers  

If using bullets or a numbered list, use the feature on the home ribbon instead of typing the bullet or 
number. If multiple levels of bullets are used, a solid black circle is used for the first level (•) and a dash 
is used for the second level (-) 

Styles 

The template has been set with specific styles for headings and paragraphs for accessibility purposes; do 
not change the style or font. 

Additional Information  

• If you have supporting information your agency’s website, include a link. 
• For accessibility purposes, web links must include the full URL (http://www.---). 
• If you are going to link text to a website (e.g., statutory reference), you will need to include the 

full URL in parentheses following the linked text. For example, “Pursuant to M.S. 16A.127 
(https://www.revisor.mn.gov/statutes/?id=16A.127)…”  

• Never use “click here” as a description for a text link. 

Don’t 

• Use custom styles 
• Use text boxes 
• Adjust the margins of the document 
• Use section breaks 
• Change the headers or footers on the templates 
• Hyphenate words. 

Page Limits  

• Agency profiles should not exceed 2-3 pages 
• Program or budget activity narratives should be limited to 1 -2 pages each 
• Small programs and budget activities should be 1 page.  

https://www.revisor.mn.gov/statutes/?id=16A.127
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Creating Accessible Documents 
The budget document must be produced in an accessible format. Instructions on steps you must take to 
make your budget narratives accessible are provided below, including an accessibility checklist. Your 
agency’s accessibility officer should also review your budget narratives before submitting them to MMB. 
Once we receive your completed narratives, we will evaluate them using an accessibility checker. If 
accessibility errors are found, the documents will be returned to you for correction. 

Use the following link to access the MINNESOTA STATE DOCUMENT ACCESSIBILITY REFERENCE GUIDES. 

For Office 2013: 

Minnesota State Document Accessibility Reference Guide for Office 2013 
[http://mn.gov/mnit/assets/MinnesotaStateAccessibleDocumentReferenceGuide2013_tcm38-
223313.pdf] 

For Office 365: 

Minnesota State Document Accessibility Reference Guide for O365 
[https://mn.gov/mmb-stat/documents/budget/budget-instructions/fy2022-
23/MinnesotaStateAccessibleDocumentReferenceGuide_O365.pdf] 

Instructions 
Formatting Text 

• Do not edit font and size, as the templates have been set with the font and size for consistent 
budget pages across agencies. 

• Do not give styles new names. Assistive technologies ONLY recognize existing MSWord style 
names. For example, do not change “Heading 2” into “Budget 2”. 

• Do not use the tools in the Font group on the Home tab to make text look like headings or other 
styles. It is ok to use the bold, italic, and underline buttons to make plain text stand out. 

  

• If you need to format text, use the Styles menu found on the Home tab. Pick the appropriate 
style for the text. 

http://mn.gov/mnit/assets/MinnesotaStateAccessibleDocumentReferenceGuide2013_tcm38-223313.pdf
https://mn.gov/mmb-stat/documents/budget/budget-instructions/fy2022-23/MinnesotaStateAccessibleDocumentReferenceGuide_O365.pdf
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Copy and Paste information into the template 

There are some changes to this year’s template. It is ok to copy and paste information into the template. 
Follow these instructions to maintain the document format: 

1. Copy the information from the source. 
2. Right-click on the document where you want the information to be placed. 
3. Choose either Keep Text Only (for text) or Use Destination Theme (or Use Destination Style for 

graphs, charts, etc.). Do not use Ctrl + v to paste the content. 

 

Insert a Table 

1. On the Insert tab, select the Table button 
2. Select Insert Table 
3. Enter the number of columns and rows you want, choose the AutoFit behavior, and click OK 

Please do not be tempted to use the Draw Table tool. Although it is convenient, this tool does not create 
an accessible table. You must select Insert Table instead. 
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Charts 

There are two ways of adding a chart that is not part of the template. 

• Import the chart from the originating program (Excel or other program) 
• As an image 

Please follow these guidelines for good accessibility: 

• Make sure the colors have good contrast in both color and black and white (print the chart to 
check contrast in grayscale). If using Microsoft Office, do not use the default colors. For ease of 
accessibility, use a built-in monochromatic color scheme. These documents are viewed both 
online and in print, so good contrast in both formats is important. Please use the approved State 
of Minnesota branding colors and color schemes. 

• If using an image of a chart:  
o Make sure the image is very clean. Images that are pixelated or blurry are difficult to 

read and look unprofessional.  
o Use the built in Snipping Tool to get a clean screen shot of the original chart. 

• Images of charts must be placed In Line (see next section) 
• Add good Alternate Text to the chart (see next section) 

Images 

1. Set “In Line with Text”  
a. Click on the image. The Layout Options button appears to the right of the image. Click 

on the button to open the menu and choose In Line with Text (Alt + JP + PO). 
b. Another way of accessing the In Line menu in Office 365 is the Picture Tools, Format 

tab. Use either the Position or Wrap Text menus. 
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Add Alt Text to your image/chart 

Alt text is used by people who are blind or deaf/blind who use screen or refreshable braille readers. Alt 
Text describes the image to the users so they can understand the image/chart. 

General guidelines for alt text: 

• Use clear, concise language. Try to not type more than 180 characters (not always possible) 
• If the image is a chart, start description with the type of chart. If the image is not a chart, do not 

start your alt text with “image of” or “picture of” 
• If you have a full description of the image in your text, refer to the text 
• For graphs and charts that are not fully described in the text, put the tabular information into 

the alt text. Use punctuation to separate groups of items and values (see “Good alt text” below).  

Good options for large charts with multiple data points: 
o Summarize the chart in the text of the document. The alt text can refer the user to the 

text. Example: “Pie chart, 2016 Yearly Expenses, as described in paragraph below.” 
o Place a link to the original table in the text of the document. The alt text can then 

summarize the chart in one sentence and refer to the link in the body text. 
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Examples: 

Poor Alt Text: 
Pie chart of yearly expenses 

OR: 

This is a picture of a chart that has all of the yearly expenses we expect to pay every year. It has 
education, healthcare, general expenses, and maintenance costs. 

Good Alt Text: 
Pie chart, 2016 Yearly expenses: Education 37%, Healthcare 18%, Maintenance 23%, General 
expenses 22%. 

How to insert Alt Text 

For Microsoft Office 2013: 

1. After inserting your image, right-click on it, and choose Format Picture to open the Format 
Picture Pane (Alt + JP + O). 

2. Click on the Layout & Properties icon and then select Alt Text. 
3. Only use the Description field. Do not type in the Title field.  

  

For Microsoft Office 365: 

1. After inserting your image, right-click on it (or Shift+F10) and choose Edit Alt Text.  
Alternately, you can open the Picture Tools, Format Tab, and then choose Alt Text. 

2. Describe the image in the text field. Use a clear, concise description. If the image shows 
something that is not written out in the body of your document, you must describe it. If it is 
something that is fully described within your document, you can refer to the existing text 
description. 
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Check Accessibility 

Using the Accessibility Checker  

1. On the File tab, select Check for Issues button and then choose Check Accessibility (Alt+F+I+I). 
Your document reopens with the Accessibility Checker dialog box. Office 365 also has a Check 
Accessibility button on the Review tab. 

2. There are three levels of results: 
• Errors: Fix all errors to make your content accessible for AT users (Exceptions: Tables do 

not need alt text. Single cell tables used for formatting do not need header rows or alt 
text).  

• Warnings: This is content that may pose a problem for people with disabilities to access 
or understand. You may need to fix these.  

• Tips: Offers tips on how to make that area better organized or more user-friendly. 
3. The bottom of the Accessibility Checker has an Additional Information dialog box that explains in 

further detail why and how a problem is fixed. 
4. Select each result; Word goes to the page with the problem and highlights the problem area. 



FY 2022-23 Budget Narrative Instructions  15 July 2020 
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Checklists 
Agency Profile 

 Update the alt text title and description for both charts. Ensure the description you provide 
describes the data within the charts for your agency. 

 Run accessibility checker. Fix any errors. 
 Send document to your agency’s accessibility officer for review. 

Small Agency Profile 

 Update the alt text title and description for both charts. Ensure the description you provide 
describes the data within the charts for your agency. 

 If you are following Option 1 for the Results section, did you follow the instructions above for 
“Importing information from other sources (Copy and Paste),” and “Using Images”? 

 If you are following Option 1, be sure to add an alt text to graphic. 
 If you are following Option 2 for the Results section, update the alt text title and description for 

the table. Ensure the description you provide describes the data within the performance 
measurement table. 

 Run accessibility checker. Fix any errors. 
 Send document to your agency’s accessibility officer for review. 

Program/Budget Activity Narratives 

 If you are following Option 1 for the Results section, did you follow the instructions above for 
“Importing information from other sources (Copy and Paste),” and “Using Images”? 

 If you are following Option 1, be sure to add an alt text to graphic. 
 If you are following Option 2 for the Results section, update the alt text title and description for 

the table. Ensure the description you provide describes the data within the performance 
measurement table. 

 Run accessibility checker. Fix any errors. 
 Send document to your agency’s accessibility officer for review. 

Agency Change Item Narratives 

 Update the alt text title and description for the Fiscal Impact table. 
 If you are using your own charts or graphics for the Result section, did you follow the 

instructions above for “Importing information from other sources (Copy and Paste),” and “Using 
Images”? 

 Be sure to add an alt text to the chart of graphic that you’ve imported. 
 Run accessibility checker. Fix any errors. 
 Send document to your agency’s accessibility officer for review. 
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Using SharePoint for Document Submission 
Establishing User Access 
Each agency has an agency secured folder on the MMB Budget Division Document Management 
SharePoint site (https://mn365.sharepoint.com/sites/MMB-Budget/SitePages/Home.aspx). Agency staff 
will need to request access to the site by submitting a Budget System User Authorization Form. 
Completed forms should be submitted to budget.finance.mmb@state.mn.us. Access is granted to 
agency users based on two types of access, Agency or Agency Legislative Initiatives. Please contact MMB 
if there are questions on which access a user may need. 

Questions related to the use of SharePoint for submission of documents should be emailed to 
budget.finance.mmb@state.mn.us. 

Narrative Templates  
All narrative templates can be found on the MMB Biennial Budget Instructions website 
(http://mn.gov/mmb/budget/budget-instructions/bibudprep/). 

Instructions 
Agencies must submit their budget narrative documents by uploading completed documents to the MMB 
Budget Division Document Management SharePoint site, as instructed in the Biennial Budget 
Instructions. Remember that once a document is uploaded to SharePoint, MMB considers this document 
as the final agency submission. If agencies have corrections or changes needed to a document after 
upload, they will need to work with their EBO to have those changes incorporated. 

For more instructions on SharePoint functionality, refer to the SharePoint Reference Guide 
(https://mn.gov/mmb-stat/documents/budget/budget-instructions/sharepoint-instructions.pdf).  

https://mn.gov/mmb-stat/documents/budget/budget-systems/budget-systems-user-authorization.pdf
mailto:budget.finance.mmb@state.mn.us
mailto:budget.finance.mmb@state.mn.us
https://mn.gov/mmb/budget/budget-instructions/bibudprep/
https://mn.gov/mmb-stat/documents/budget/budget-instructions/sharepoint-instructions.pdf
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Uploading a Document to SharePoint 

1. Open a web browser and go to the Budget Division Document Management SharePoint site URL: 
https://mn365.sharepoint.com/sites/MMB-Budget/SitePages/Home.aspx. If prompted, log in 
with your employee ID and password. 

2. Select your agency from the menu on the left-hand side of the page. 

 

3. Select the Biennial Budget folder 

 

4. Select the 2020-21 Biennial Budget folder 

https://mn365.sharepoint.com/sites/MMB-Budget/SitePages/Home.aspx
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5. Select the Background Narratives folder.  This is the folder where agencies will upload their final 
submitted budget narratives.  Also within the Background Narratives folder are folders called 
2018-19 Narratives and Reference Materials, which have information that will help agencies 
prepare their narratives, i.e., 2018-19 published budget narratives in the new templates and 
2017 spending information for the Agency Profile pie and bar charts. 

 

6. Select the Upload tool 

 

7. Search your computer for the document or documents you wish to upload to the SharePoint 
site.  Click the Open button.  
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8. SharePoint will bring you to the document properties menu. Please verify that the name listed in 
the File name box is using the naming convention listed below: 

Naming conventions for the templates are as follows: 

Template File Name When Saving the Document to SharePoint 

Agency Profile Agency Code Agency Profile (e.g., G02 Agency Profile) 

Program/Activity Template Program/Activity Number-Name of Program or Activity 

9. Select Open and upload your document to the document library 

 

For more instructions on SharePoint functionality, refer to the SharePoint Reference Guide 
(https://mn.gov/mmb-stat/documents/budget/budget-instructions/sharepoint-instructions.pdf) 

https://mn.gov/mmb-stat/documents/budget/budget-instructions/sharepoint-instructions.pdf
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